The Fetal Medicine Foundation
The First Trimester Screening Program
Risk calculation

Version 2.8.0 based on the FMF2012 specifications
Release date: 11.09.2013 – 2.8.0 FTS Version

1. Welcome to the First Trimester Screening program
2. Program requirements
3. Installing the program
4. Program licence
5. Deciding which risks to use
6. Booking a first trimester patient
7. Searching the database
8. Backing up the database (IMPORTANT – please read)
9. First Trimester Audit
10. The Help pages
11. Keyboard and shortcuts
12. Frequently asked questions
13. Product information
14. Statement of conformity of medical device products
1. Welcome to the First Trimester Screening program

Intended use
This is the Fetal Medicine Foundation software for the calculation of risk of aneuploidies by a combination of maternal history, pregnancy characteristics, fetal nuchal translucency measurement, other ultrasound markers, as well as maternal serum biochemistry in the first trimester. The program also gives separate risks for preeclampsia, fetal growth retardation and spontaneous preterm delivery based on maternal history and pregnancy characteristics, ultrasound, biochemical and biophysical markers in the first trimester. In addition, it provides a detailed database of patients screened, a reporting system and a very detailed audit section.

All terms of the national regulations for users of medical devices apply, as well as those of other relevant legal regulations. If national or international laws, directives or regulations are limiting the intended use of the product, they have absolute priority over the statements above.

The group of permitted users is defined by the precise definition of the intended use. The customer must ensure that all relevant regulations concerning data protection are met and that the necessary data security procedures are in place. astraia provides you with a comprehensive user access management, enabling you to define who is allowed to access, change and enter certain data. Access to the astraia system is protected by user names and passwords.

Please also ensure that the system is operated by adequately trained personnel only.

The FMF wish to make their risk calculation software widely available, but also wish to protect patients by limiting access to those who are appropriately trained and audited. The program licence addresses this specific issue, requiring that both the centre and individual sonographers be authorised before accessing the risk calculation component of the program. The licence is supplied only by the FMF, and not by software companies involved in the design and manufacture of the program.

The intention of this manual is to give you a quick overview of the program; for more information concerning the FMF First Trimester screening program, we refer you to the FMF website (www.fetalmedicine.com). For more information about the actual risk calculation software, we encourage you to consult the extensive Help pages included in the program (see section 16) and to read the accompanying document Guide for the First Trimester Screening Module.
2. **Program requirements**

The First Trimester Screening program uses a standard SQL database.

**Minimum Hardware/Software Requirements**
- Windows Vista Business, XP Professional, 2000, latest service pack installed
- 512 MB or more memory (RAM)
- 20 GByte or more Hard Drive, 5 GByte free
- TCP/IP protocol installed
- backup device or network backup process installed

If you want to install the FTS program on a Macintosh OS, please note this is only possible on a Windows virtual machine (e.g., VMWare Fusion, Parallel, Oracle VirtualBox) or via Bootcamp.

**Networking the program**
The software can be networked. Network installations must be arranged in direct consultation with astraia software, and an installation fee will be charged ([support@astraia.com](mailto:support@astraia.com)).

**Your language setting**
The correct language is usually automatically detected, but if this is not the case, or you wish to change your settings, go to **Options - Appearance** and select the language of your choice from the list of Languages provided.
3. **Installing the program**

(a) Download the **First trimester Screening Program** setup from the given link. To start the software installation, double click on the `setup.exe` file.

(b) The Welcome screen will advise you to shut down other applications. Having done this, select **Next**.

![Welcome Screen](image1.png)

(c) The program will automatically install to `C:\Program Files` and create a subfolder within this directory called FMF. You can choose to direct the new folder to another location, but you must remember where you put it, as you will have to send all subsequent licences and updates to the same place. Unless there is a good reason to change this, we would advise that you use the default setting and simply click **Next**.

![Folder Selection](image2.png)
(d) With the next screen you are asked if you wish to have a quick launch icon and a desktop icon to make accessing the program simpler. We would recommend that you opt for both of these additional icons, ticking both boxes, then selecting Next.

(e) The following screen confirms your selections. If these are OK, click on Install.
(f) The program will take a short time to install all the files, at the end of which you will be told that the installation is complete. Choose if you want to go straight ahead and launch the program or not, using the tick box and then press Finish.

(g) Depending on your system, you may now encounter some problems with your firewall and be shown some low-risk security alert warning messages. On this occasion, it is safe to ignore them by selecting the option **Always allow connections to this program on all ports**, then OK. You may need to do this on several occasions before you are given access to the program, so keep trying.

(h) Please note that before you can enter patient data, you will need to license your program (see program licence).
4. **Program license**

The FMF wish to make their risk calculation software widely available, but also wish to protect patients by limiting access to only those who are appropriately trained and audited. The program license has been designed to do this, requiring that both the centre and individual sonographers be authorised before accessing the risk calculation component. The license will be supplied only by the FMF, and not by software companies involved in the design and manufacture of the program.

Having installed the program for the first time, you should be directed straight to the license screen, otherwise you can access this at any time by selecting **Options** on the front screen. The following information is displayed in the License screen:

You can access this at any time by selecting **Options - License** on the front screen. The following information is displayed in the license screen:

**Licensed users**

Each sonographer must be individually licensed in order to have access to the risk calculation package.

Each certified sonographer has to download and import her/his individual license (from FTS version 2.3.0 on, there is no longer a centralised license that covers all certified sonographers from one same Centre).
This is done by downloading a license file individually for every FMF user ID number including the assigned FMF operator name. Each accredited sonographer should have been assigned a code when they were accredited. If you do not know what your code is, the FMF will be able to provide you with this information. Each sonographer is also be assigned a license "expiry date". A sonographer who has passed their certification for the additional ultrasound markers will also be given access to the adjustment of risk by the finding of the additional ultrasound markers. The additional markers that require certification are Nasal Bone, Tricuspid regurgitation, Ductus Venosus PI. Since version 2.5.0, Facial angle is no longer used. The calculation of Preeclampsia and Fetal growth retardation also requires certification but Preterm delivery is covered by the general ultrasound certification.

Without a license or with an expired license, the risk calculation will not be available to the user, however no data, e.g. previously calculated risks, is lost. For further information about the licensing process, please contact the FMF directly.

Provided you have completed the online course for the 11-13 weeks scan on the Fetal Medicine Foundation website and have internet access, you can download your license from the FMF website directly in this screen - Download license. You will need

- Your FMF user ID
- Your login name
- Your password

The downloaded license will be added to the user list.

Alternatively, you can download your license from your personal FMF site as a license file and copy it to the computer where FTS is installed; you can then import the license into the FTS program. By clicking on Import license, you will be able to search for your license file. If the import was successful, you will get a message and the License configuration window will have updated the information (such as your expiration date and any changes to the ultrasound marker certifications).

When selecting which file to import, you may need to change the Files of Type that is being displayed to All files (*.*) in order to see and select the file that you need to import. When you are at the correct location, select Open. The license will be imported automatically.

The following information is visible in the configuration window: the licensed users (Name), their FMF user Id, the expiry date of the user's individual license and the permission to use ultrasound markers in general (US), nasal bone (NB), tricuspid regurgitation (TR), ductus venosus (DV) and pregnancy complication which includes preeclampsia and fetal growth retardation (PE) as criteria for the risk calculation - (Y meaning Yes, N meaning no permission)

For configuration of the risk go to section Program Options. The operator code will be entered with the sonographer's name when the operator is selected.

Reasons why you cannot access the risk screen could be:

- The sonographer's license has expired (select Options to view license details)
- Your name has not been imported in the programme FMF risks screen as a valid operator (You will need to know what your own FMF ID is, select Options to view license details)
• You have not imported the license file correctly (select Options to see if there are any license details)

User browser to find license file given to you by FMF

You may need to change the file type to All Files

Click Open to import license
5. Deciding which risks to use

Risk at time of screening or term risk?

About one third of pregnancies affected by Down’s syndrome will miscarry spontaneously between 12 weeks and term. Therefore the risk of carrying an affected fetus will go down as the pregnancy advances and the risk at term is lower than the risk at the time of screening. There is no correct or incorrect way of stating the risk, as long as it is clear to both clinician and patient which risk is being used – the risk at the time of screening or the risk at term.

This program will give you the option of using either, but to avoid confusion it is essential that you decide which you intend to use and then stick to this format. Switching between risks will be very confusing if you go back to look up details of a patient previously screened and it may not be clear which risk was actually given to the patient.

The program default setting gives the risk at the time of examination, but if you wish to use term risks, select Options from the front screen, then use the tabs to change to the “Other settings” sheet and select at term for Risks of aneuploides.

Also in Options – Other settings you can choose to calculate and print or calculate but not print the risk for Trisomy 13 and 18, PE and FGR and Preterm delivery. There is also the option to exclude the additional markers from the risk calculations (if certified).
As of version 2.5, separate screen-positive cut-off values can be assigned for trisomy 21 and trisomy 18 and 13. The default cutoffs are 1:100 for trisomy 21 and 1:50 for trisomy 18+13. Note that these cutoffs are appropriate only for risks at examination.

6. Booking a first trimester patient

This section will show you the steps for completing a First Trimester Scan in the FMF software.

By clicking on the field Patients on the desktop - or pressing the key P - you can enter new patient data and examination results.

The Patient Lookup will open. Always fill the fields Name, Other names and DOB before you book a patient with the Book button or the function key F2.

If the patient comes for her second, third, ... pregnancy, choose the number of pregnancy from the list available:

After booking the patient the Patient record will open, and a series of screens will be displayed, titled:

Patient data
History
Ultrasound
Biochemistry
Mean Arterial Pressure
Risks / Counselling
Comments
Karyotype
Outcome
The Patient Data screen is the first one, but all other screens can be accessed by simply clicking on the tabs at the top of the page.

**Note:** A blue title characterizes a field that must be filled; the program will not allow you to move on to another screen until this has been done. A green title characterizes a field that needs to be filled in for the risk calculation. Whilst the risks are not calculated if these fields are not filled in, you will not be prevented from navigating to another screen. Note that if a field is both mandatory (blue) and required for the risk (green), the colour blue is assigned.

Patient data

Whilst filling in the patient address and referring doctor can be useful for subsequent follow-ups, the only mandatory fields are patient names and Date of birth.
History

If a Parity > 0 is entered, the fields for Spontaneous deliveries between 31-36 weeks, Deliveries at or after 37 weeks appear, Preeclampsia in a previous pregnancy and previous small baby appear.

In case you do not know if a previous baby falls in the small category, a birthweight calculator is made available. By clicking the **Birthweight calculator button**, a dialog appears where the birthweight and gestational age at delivery can be entered. A message will appear informing you whether the baby was Below or Above the 5th centile, and the Previous small baby list entry will be automatically filled to reflect the result when you click Apply.

**Birthweight Calculator**

![Birthweight Calculator](image)
The program automatically assigns today’s date, but this can be overridden with the correct date if an examination is being entered retrospectively.

The operator name and the FMF ID are entries in this screen. The list of Operators will automatically be filled from the license information generated by the Fetal Medicine Foundation (the license information contains the name of the operator and the respective FMF user code) and cannot be changed. It is extremely important that you select your name as Operator before calculating the risk.

The other mandatory fields to complete the First Trimester scan are the crown-rump length (CRL), nuchal translucency (NT) measurements and fetal heart activity. A decision must be taken on how to date the pregnancy – either by CRL or LMP (or conception date in the case of assisted reproduction) by clicking on the button **Gestational Age**.

All the other ultrasound fields provide useful additional information and are recommended as part of the routine first trimester scan; however they can be left blank. Note that Minor markers and Facial angle have been removed from version 2.5.
Biochemistry

If you have a result from maternal serum biochemistry, go to the next page, Biochemistry, and fill in the results. Provided your laboratory equipment is one on the FMF-approved list, the multiples of the median (MoMs) will be calculated automatically when you enter the results. If you do not use one of the FMF-approved biochemical assays, your own laboratory must give you the MoM values. These can be entered directly into the program and the risk will be provided on the basis of these. However, the FMF cannot take responsibility for risks calculated using biochemical systems that have not been approved, and a comment will appear on the report to reflect this.

Biochemical MoMs are calculated using the gestational age derived from CRL, regardless of the clinical decision about how to date the pregnancy. However the MoMs can be corrected for several other factors, including weight, racial origin, smoking, parity, assisted reproduction and diabetes; these can all be entered in the History page. Dichorionic and monochorionic twins are also a factor but only for PAPP-A and free ß-hCG, not PIGF.

**Note for FTS version 2.5.0:** PIGF has been added from this version onwards; it is included in the risk calculation. However whilst a concentration and MoM value for AFP (Alpha-fetoprotein) can both be entered, AFP is not used in the risk calculations.

There is also the possibility of including the MoMs from a previous normal pregnancy. Tick the check box MoM values from a previous normal pregnancy. Only the free ß-hCG and PAPP-A MoMs are used in the risk calculation.
Mean Arterial Pressure

The mean arterial pressure at 11-13 weeks is increased in pregnancies that subsequently develop preeclampsia and in those that deliver small-for-gestational-age neonates without preeclampsia, but the levels are normal in trisomic pregnancies.

Blood pressure should be taken by automated devices which are calibrated at regular intervals. The women should be in the seating position, their arms should be supported at the level of their heart and either a small (<22 cm), normal (22-32 cm) or large (33-42 cm) adult cuff should be used depending on the mid-arm circumference. After rest for five minutes blood pressure should be measured in both arms simultaneously and a series of two recordings should be made at 1-minute intervals.

You should record all four measurements of MAP (two from each arm). If your machine does not provide measurements of MAP then record the systolic and diastolic measurements and the software will calculate the MAP. The software will calculate the average of the four recordings and use this value to calculate a multiple of the median (MoM) corrected for maternal weight, which is then used to estimate the patient specific risk for pregnancy complications.

NOTE

From version 2.5.0 Pre-eclampsia is no longer a separate screen. The FMF software will still calculate an individualised risk for Preeclampsia (PE) developing at or before 34 weeks as well as one for Fetal growth retardation (FGR) at or before 37 weeks, based on the maternal history, uterine artery Doppler PI, Mean Arterial Pressure, PAPP-A and PI GF. The required fields to undertake risk assessment of PE and FGR are all in History: age, weight, height, racial origin, smoking (FGR only), parity, chronic hypertension, antiphospholipid syndrom, systemic lupus erythematosus, diabetes mellitus and previous history of preeclampsia.

The Pre-term delivery risk is a new calculation which requires as required fields age, height, racial origin, method of conception, smoking and history of spontaneous delivery. These factors can then be combined with cervical length (in the Ultrasound screen) to provide a risk for pre-term delivery.
Risks / Counselling

The results of the risk calculations are displayed in **Risks / Counselling**. A risk will not be given until the box has been ticked to confirm that the patient has been counselled and given her consent. Press the Calculate button to get the risks. The risks are displayed along with a description of the factors used in the calculation (methodology) in text form. A graph is displayed below showing the Trisomy 21 risk before and after adjustment.

If you change any data in the patient record which affects the risks, the risks before you made the changes will continue to be displayed, however, the Recalculate button will be highlighted in **red** and you will not be able to print or save this record without recalculating (by pressing the Recalculate button).

Comments

Free text can be written in the **Comments** section. Anything written here will appear on the printed report. Standard comments can be composed by selecting **Add new item** (icon at the top left hand side), then give the statement an identifiable name (eg monochorionic twins) in the item name section, and use the text box to compose a “standard comment” for that particular condition. Double clicking on the name will automatically add this statement to the report.

Karyotype and Outcome

It is good practice to follow-up the outcome of all pregnancies screened and record this information on the database. The audit section and pre-set queries will allow you to access information about the abnormal cases easily.
**Printing reports**

You can print a report by selecting **Print** from the **File** menu (Ctrl-P for short). To close the report, press F10, or click on the cross in the top right corner of the report window.

If you want your Centre name to be displayed on the report, go to Options – Printouts and enter your Clinic or Hospital name manually.
7. **Searching the database**

Click on the **Queries** button in the main menu. The database comes with a number of pre-defined queries. To run any query in the list, select it and then click on **View**, **Count**, **Print** or **Export** results.

The **View results** window displays all the selected records in a table for the corresponding query.

The **Count results** returns the number of rows in the result page, which corresponds to the number of patients that meet the selection criterion of the query.

Selecting **Print results** shows the Print dialog, where you can select to print or preview the results in portrait or landscape format and sort by any of the chosen columns.

The option **Export results** writes the results of the query to a file in Excel format which can then be saved to a location of your choice.

**Creating and Editing queries**

Click on the field **New Query** to create a new SQL query or select **Edit Query** to change the existing SQL statement. You can do simple changes to the existing queries, for example to change the query 'FMF: risk cut-off (T21 > 1 in 100, T18+T13 > 1 in 50)' to a query that selects all trisomies with a risk greater than 1 in 100 – click on **Edit Query** and change the last statement:

```
WHERE Fetus.Adjusted_risk_Tr21<100.0 OR (1/Fetus.Adjusted_risk_Tr18 + 1/Fetus.Adjusted_risk_Tr13) > 0.02)
```

to, for example
WHERE Fetus.Adjusted_risk_Tr21 < 100.0 OR Fetus.Adjusted_risk_Tr18 < 100.0 OR Fetus.Adjusted_risk_Tr13 < 100.0

However note that when saving this new query, you overwrite the original one. A safer approach is open the original query, copy the content, close this query. Then, create a new query (New query), paste into it the original query, give it a new Description and make the changes before saving.

Additional queries can be created by users with SQL experience, or by request to astraia software. If you want to implement new queries to your First Trimester Program please contact astraia (support@astraia.com) for further information.

Please note that astraia software gmbh does not take any responsibility if you edit the existing queries.

Delete queries
If you want to delete a query, click on the field Delete query.
8. **Backing-up the database**

About once a week the FMF is asked if patient records can be restored from audit data because a computer has crashed losing all records and there is no back-up. **We cannot!**

**Please perform regular back-ups.**

This is entirely for your own protection in the event of a computer failure. The program will ask you if you want to do this every time you close the program and we recommend that you always answer **Yes**. The first time, you will be asked to select the backup path. With every further backup the path chosen in the first place will be automatically selected. If you want to change the backup path, you can do so by going into **Options - Other settings** from the front screen.

When selecting a directory for the backup of the database please take the following into account:

If your computer is not connected to a network, choose a backup directory on a separate hard drive (if available). If this is not possible, backup the database onto a backup directory on your hard drive but, in addition, save a copy of the database onto a different data carrier, for example on a CD or USB stick.

If your computer is installed on a network, the backup should be performed by your system administrator who should select a backup path on a different computer/hard disc from the one that you are currently using.

**Summary:**

(a) open My Computer on your desktop – double click Local Disk (C:) – go to File – New – Folder – rename it to FMF_backup

(b) open the First Trimester Screening Program – go to Options – Other settings: click on the three dots button as shown below:

![Screenshot of Options - Other settings](image)
(c) look for the FMF_backup folder from the list **Save In**, in the directory where you have saved it (the example below shows the folder in C:\FMF_backup) double-click on it and **Save**.

![Select backup directory](image)

**Restoring a backup on a new PC:**
This procedure depends on which database the original FMF program was working with.

The earlier versions of the FTS program (FTS 2.0.3) have a Sybase database environment. In this case, the backup consists of 2 files: **fmf.db** and **fmf.log**
From FTS version 2.2.0 onwards, the FTS program was changed to use a free-of-charge Derby Java database. With this, the backup consists of a **folder fmf** with **subfolder** such as **log** and **seg0**...

If you need to restore a database backup from the **Java Derby** database with a database folder fmf then do the following:
Please install the latest FTS version and copy the complete folder fmf in your backup into the new FMF installation folder C:\Program Files\FMF, overwriting the existing folder fmf there. You will end up with the following folder structure: C:\Program files\FMF\fmf.

If you need to restore a database backup from a **Sybase** database you will need to install the FTS 2.0.3 version first and then copy the files fmf.db and fmf.log from the backup into the FMF installation folder C:\Program Files\FMF.
After this update your FTS program to the latest FTS version.
Please contact FMF for further help and for the download location of the old FTS 2.0.3 version.
9. **First Trimester Audit**

Open Audit from the main menu. A dialog appears allowing you to select operator and date range (optional). The audit screen contains a summary page, NT distribution, NT Values, distribution and values for the biochemical markers free ß-hCG, PAPP-A, PIGF, and AFP, distribution and values for Ductus venosus PI, Uterine artery PI, and MAP. Further information is available in Details, Medians, CUSUM and FMF Statistics.

<table>
<thead>
<tr>
<th>Summary</th>
<th>NT Distribution</th>
<th>NT Values</th>
<th>Free ß-hCG</th>
<th>PAPP-A</th>
<th>PIGF</th>
<th>AFP</th>
<th>Ductus venosus PI</th>
<th>Uterine A PI</th>
<th>MAP</th>
<th>Details</th>
<th>Medians</th>
<th>CUSUM</th>
<th>FMF Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT from</td>
<td>23/08/2011</td>
<td>to 15/06/2012</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Exporting Audit Data**

The Export data button allows you to save the results of your audit to a text file on your local computer. You can upload this Audit file to your personal account on the Fetal Medicine Foundation website. Log in to your account on www.fetalmedicine.com and go to Audit / licensing and follow the procedure described. The exported data is only the data used to produce the audit report as seen on the audit screen - no patient names or addresses, and no comments entered in the data entry screens are exported.

For your clinic or hospital name to appear on the audit report please make sure you have entered the name in Options – Printouts.

Note that **quality review and ongoing certification** in nuchal translucency, nasal bone, ductus venosus, tricuspid flow and Uterine artery PI are mandatory for all certified users. For more information refer to the Fetal Medicine Foundation website: [http://www.fetalmedicine.com/fmf/training-certification/certificates-of-competence/11-13-week-scan/nuchal/](http://www.fetalmedicine.com/fmf/training-certification/certificates-of-competence/11-13-week-scan/nuchal/)

Images and data for the audit should be submitted **online** via the Fetal Medicine Foundation website. If do not have internet connection, you could send them to:

**The FETAL MEDICINE FOUNDATION**
(Registered Charity No. 1037116)
First Trimester Screening Programme
137 Harley Street, London WIG 6BG, UK

Tel: +44 (0)20 7034 3070
Fax: +44 (0)20 7034 3071

e-mail: certification@fetalmedicine.com
Web: www.fetalmedicine.com
Internal QA

In addition to the FMF audit, all centres are encouraged to perform their own internal quality assurance on a monthly basis by:

- "Spot-checking" three images from each sonographer, selected entirely at random
- Examining the NT distribution of each individual sonographer using the automated audit module incorporated within the FMF risk calculation software.

The program makes both processes very simple, having an automated audit function that displays the results for both the centre as a whole and individual operators, and an export function to facilitate sending the data to the FMF.

Please explore the automated audit section and look at this on a regular basis to monitor your own performance.

Accessing Audit Data

After choosing Audit in the main menu there is a brief delay while the data is collected and examined. The automated report that appears will give you a complete overview of your NT distributions for both your centre and individuals, with both graphical and statistical displays. It also provides an analysis of your biochemical data and a list of the abnormal cases recorded on your database.
10. The Help pages

The help pages contain a vast amount of information about both the program and the First Trimester scan. They can be accessed using the Help button at the top left hand side of the screen and we recommend you have a thorough look through. The following information is included:

The First Trimester Screening Program
Guide to Using the Program
  The Desktop
  The Patient List
  Navigation
    Entering Patient Data
    Entering History Data
    Entering Ultrasound Data
    Entering Biochemistry Data
    Entering Mean arterial pressure
    Risk Assessment
    Comments
    Karyotype
    Outcome
  Entering data
    Editing Popup Lists
    Editing Helper Lists
    Editing Lookup Tables
  Printing reports
  Querying the database
  Licence, Language and Options
  Keyboard and short-cuts
  Menu bar
  Backup database
  Submitting Audit Data
  How Do I...
  Program Requirements
  Technical Support

The 11-13th Weeks Scan Book
  First Trimester Diagnosis of Chromosomal Defects
  Sonographic Features of Chromosomal Defects
  Increased NT with Normal Karyotype
  Multiple Pregnancies

Risk and Protocols
  Risk license
  Deciding which risks to use
  Booking a first trimester patient
  Risks
  Assisted Conception
  Cervical length
  Crown-rump-length
  Ductus venosus
  Diaphragmatic hernia
  Exomphalos
  Fetal heart rate
  Major markers
  Maternal serum biochemistry
  Megacystis
  Mean arterial pressure (MAP)
MoMs
Multiple pregnancies
Nasal bone
Nuchal Translucency
Preeclampsia
Racial origin classification
Uterine arteries Doppler
PIGF
Risks for hypertensive disorders
Tricuspid regurgitation
Protocol – Measurement of Nuchal Translucency
Protocol – Measurement of Fetal Nasal Bone
Protocol – Assessment of Fetal Tricuspid Flow
Protocol – Assessment of the Ductus Venosus
Protocol – Assessment of Uterine Artery Doppler
Protocol – Measurement of Cervical Length
11. **Keyboard and short-cuts**

The following provides a list of useful short-cuts to make navigating around the program quicker and easier.

**Keyboard**

- **F1** shows the help file
- **F7** displays a graph for the current value, if available
- **F8** displays all charts in the current block
- **F10** close a patient record
- **Esc** exit the list editor or patient list without saving changes

**Short-cuts**

Short-cuts are a key or a key combination that perform an operation. Options with an underlined letter define the key combination of the short-cut (for example: File-Save, short-cut Ctrl-S).

**Menu operations:**

- **Ctrl-P** print an examination report
- **Ctrl-S** save patient data
- **Alt-M** messages window
- **Ctrl-B** backup database

**Editing operations:**

- **Ctrl-X** cut the selected text
- **Ctrl-C** copy the selected text
- **Ctrl-V** paste the text from the clipboard
- **Ctrl-Z** undo the last action
- **Ctrl-Y** redo the undone action

All list fields can be quickly filled by typing the initial letter of the chosen entry. For example, a list with 'yes' and 'no' entries can be filled by typing 'y' or 'n'.

*Another useful tip is that double clicking on an empty date field will automatically fill in today’s date.*
12. Frequently asked questions

Number of pregnancy
Go to the patient lookup and fill in the Name, Other names and DOB details. Click on the list for Pregnancy number and choose the appropriate number. Add the patient to the database with the Book (F2) button.

How to add a new operator to the list?
If you import a new FMF user license the user will be automatically displayed in the list of Operators on the Ultrasound screen.

How to export the Audit data?
On the Program desktop, enter the screen Audit. By clicking on the Export button you can store the data on a USB stick (we suggest a file name similar to a:\your_centre.txt). The data extracted is only the data used to produce the audit report you have seen - i.e. no patient names or addresses, and no comments entered in the data entry screens are exported.

How to import a new license?
Important: Your current risk license will not be valid for the new risk module. Before you install the update please make sure you have completed the Online course the 11-13 weeks scan on the Fetal Medicine Foundation website.
Each certified sonographer has to import her/his own license into the risk calculation program she/he is using either by downloading it in the program directly (Options – FMF risks – Download license) or by downloading a file from her/his individual FMF user site and importing this license file into the software (Options – FMF risks – Import license).
→ Download license option: Provided you have internet access, you can download your license from the FMF website directly in the screen OPTIONS - FMF RISKS - Download license. You will need

- Your FMF user ID
- Your login name
- our FMF password

The downloaded license will be added to the user list, it will not overwrite the existing FMF user information.
→ Import license option: Alternatively, you can download your license file from your personal FMF site and copy it to the computer where the FTS is installed; you can then import the license into the program. By clicking on Import license, you will be able to search for your license file.
If you have problems with your new FMF license please contact fmflicense@fetalmedicine.com. If you have any more questions regarding the First Trimester Risk module please contact fmfcertification@fetalmedicine.com.

How to save changes?
To close the record and save it you can click on the cross at the top right of the record, or select Exit from the File menu. If the record has changed you will be prompted to save or abandon the changes. To save the patient record at any time, press Ctrl + S, or select Save from the File menu.
How to add/delete a Fetus tab?
You can record a multiple pregnancy by simply clicking on New Fetus tab in the Ultrasound section. Alternatively, you can delete an incorrect entry of a New fetus, by right mouse clicking on the fetus tab in question and choosing Delete this tab page.

How to edit a list?
Move the focus to the list you want to edit, open the list with a double click and click on Change this list or press Alt + Enter.

How to backup the database?
Set or change the backup directory in Options - Other settings. For Backup press Ctrl + B, or select Backup database from the File menu. See database backup for more details.

How to add messages to a patient?
Press Alt + M, or select messages in the Data menu. You can then save messages for the active patient, such as changes in the examination date or time or messages for another operator, in a text box. Each time the patient is opened the message is automatically displayed, so that other users can see the message as well.
You can add or change the messages. Delete the message if you do not want the message to be displayed any more.

More information on all of these questions can be found in the program online Help.
13. Product information

The First Trimester Screening Program

Software for the calculation of risk for aneuploides and pregnancy complications based on maternal history and pregnancy characteristics, the measurement of the nuchal translucency, maternal serum markers and extra ultrasound marker findings at the 11-13+6 weeks scan.

Version 2.8.0 based on the FMF2012 specifications - Release date: 11.09.2013
© 2013 The Fetal Medicine Foundation

The Fetal Medicine Foundation
www.fetalmedicine.com

137 Harley Street, London
W1G 6BG, UK
Tel: (0044) 20 7034 3070
Fax: (0044) 20 7034 3071
fmfcertification@fetalmedicine.com

\[CE\] 0483

The First Trimester Screening Program was developed in accordance with our quality management procedures which are certified to ISO 13485:2010 standards. These procedures fulfil all legal requirements for medical devices as specified by the Medical Device Directive (MDD) and the European Council Directive 93/42/ECC.

Furthermore, the risk management has been carried out according to ISO 14971:2009.

We make continuous efforts to keep our software up to date with the following technical standards:

- EN 62304
- EN 62366
- EN 1041
- EN 980
- EN 591

Please Note:
astraia software gmbh cannot take any responsibility for your data security and integrity.

Please read this manual very carefully and in case of any question please contact our technical support. We advise you to keep regular backups of the database (preferably twice a day) and other important files (see chapter 8), which should be stored separately from the machine(s) on which you are running FTS. These precautions can protect you from data loss and allow you to recover your data from your backup files if necessary.
Product end of life:
The First Trimester Screening Programme 2.8.0 was released on 11th September 2013.

astraia customer support for The First Trimester Screening Programme 2.7.0 will lapse on 30th September 2014.

astraia customer support for The First Trimester Screening Programme 2.5.0 will lapse on 31st July 2014.

astraia customer support for The First Trimester Screening Programme 2.3.2 will lapse on 31st December 2013.

astraia customer support for all previous versions is discontinued.

Every version will be supported for an additional 12 months after the release of a new version.
Declaration of conformity for medical devices
according to guideline 93/42/EEC appendix II

CE 0483

astraia software gmbh
Occamstraße 20, D-80802 Munich, Germany

Wir erklären hiermit in alleiniger Verantwortung, dass das Produkt
We hereby declare under our sole responsibility, that product

Produkte, Bezeichnung / Products, name
The First Trimester Screening Programme
(astraia software for women's health obstetric and gynaecological database application)

auf das sich diese Erklärung bezieht, die Forderungen der Richtlinie 93/42/EWG über
Medizinprodukte erfüllen.

Das Unternehmen unterhält ein QM-System gemäß den Anforderungen der EN ISO 13485.
The organisation supports a QM-system according to the requirements of EN ISO 13485.

Ferner wurde das Risikomanagement nach EN 14971:2007 durchgeführt.
Furthermore risk management has been carried out according to EN 14971:2007.

Diese Erklärung gilt für alle Produkte die bis zum 21.03.2017 hergestellt werden.

This certificate is valid for all products made until March 21st, 2017.

Das Produkt gehört zur Klasse Ila.
The product belongs to Class Ila.

Benannte Stelle / Notified Body 0483
mdc medical device certification GmbH, Kriegerstraße 6, 70191 Stuttgart, Germany

München / Munich, 20.06.2012

Roland Denk – Managing Director